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 WHAT’S POSSIBLE? 
 

 Use publisher-provided exam software to create and export a quiz or exam for a 
SacCT course (TestGen, ExamView, & EZTest will be briefly covered in this handout) 

 Export a Word or text file from the publisher into a SacCT course, using Respondus1

 Export a Respondus-formatted test bank file into a SacCT course  
  

 
 

 USING PUBLISHER-PROVIDED EXAM SOFTWARE 
 
Some textbook publishers provide exam software that can be used to create an exam or quiz 
that can then be used to generate a file for import directly into your SacCT course.  If  you plan 
to use a test bank from your publisher in your SacCT course, this method is the most 
expeditious. 
 
The process of  creating an exam file (for export to SacCT) using publisher exam software is 
covered in this section.  Three of  the more common applications are covered, although 
additional detail regarding the exam-authoring environment can be acquired from the 
application’s online manual or other help pages.  The support Web site for each of  the three 
software packages is listed below, in the corresponding sections.  
 
                                                

 

 

 

1 Respondus is an application that can be used to create quizzes for SacCT.  Additional information can be 
found on our Respondus support site: http://www.csus.edu/atcs/tools/respondus/index.stm 
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NOTE: Before you begin, make sure that you are running the latest version of  the exam software you will 
be using.  To check to see if  you are running the latest version, you can check for a version update (usually done 
from the Help menu of  your software), or see the support Web site for your exam software (listed in the 
following sections).  Previous versions of  exam software may not include support for our version of  WebCT. 
 

Creating an Exam 
 

 TIP : When creating a name for your new exam, refrain from including special 
characters (such as *, ( ), #, @, $, etc).  Once the exam has been imported into 
your SacCT course, the quiz title can be changed to include special characters, if  
you would like. 2 
 

TestGen  
Additional information regarding TestGen, including an overview, FAQs, information about 
acquiring a copy of  the software, and other support pages, can be found on the TestGen Web 
site (http://www.tamarack-software.com/).   

1) BUILD YOUR QUIZ 
step 1. Create a new Paper Test, or use the TestGen Wizard.   

• If  the test bank that you want to use for your exam is not listed, you will need to use 
the “Add Test bank to Library” option in TestGen (if  you have the test bank on your 
computer), or visit the Pearson/TestGen site in order to download the test bank for 
your textbook.  Instructions for doing this are listed on the TestGen site, Open Test 
Bank Library support page (http://www.tamarack-software.com/forum/open-test-
bank-library). 

• In general, you will select questions from your test bank library to add to your paper 
test.  Once added, questions can be rearranged or removed. 

• For additional instruction on creating an exam using TestGen, see the TestGen 
support pages, or the manual for the application, if  you already have it. 

step 2. Save your completed exam, in the TestGen format (the Save option should save, by 
default, to the TestGen format). 

2) EXPORT TEST 
step 1. From the File menu, select the Export option.  
                                                

 

 

 
2 This is especially important if  you have included images in your quiz questions.  Once the quiz or 
exam is in SacCT, images may not show if  you have included special characters in the file name. 
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step 2. From the Export Test window, select the option labeled QTI (WebCT CE 6, WebCT 
VISTA), then click OK. 
  
  
  
  
  
  
  
  
  
  
  
  
  
 

step 3. Follow the prompt to select a location on your computer to save the export file, then 
save the file.  Note the location of  the saved file on your computer.  Do not attempt to 
open it. 

Select QTI 
(WebCT CE 6, 
WebCT VISTA) 

 

 

 

ExamView 
Additional information regarding ExamView, including an overview, FAQs, information about 
acquiring a copy of  the software, and other support pages, can be found on the ExamView Web 
site (http://www.einstruction.com/support_downloads/assessment/examview/index.html).   

1) BUILD YOUR QUIZ 
step 1. Create a new test, using the QuickTest Wizard or by creating a new test from scratch. 

• If  the question bank that you want to use for your exam is not listed, you will need to 
switch to the Question Bank Editor (File > Question Bank Editor) and add your 
question bank from there.  If  you don’t have the question bank you need on your 
computer, visit your publisher’s Web site in order to download the ExamView 
question bank for your textbook.   

• In general, you will select questions from your question bank library to add to your 
test.  Once added, questions can be rearranged or removed. 

• For additional instruction on creating an exam using ExamView, see the ExamView 
support pages or the manual for the application, if  you already have it. 

step 2. Save your completed exam, in the ExamView format (the Save option should save, by 
default, to the ExamView format). 

2) EXPORT TEST 
step 1. From the File menu, select the Export option, then select the option labeled WebCT 

CE 4-6/Vista 3-4, then click OK. 
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Select WebCT CE 
4-6/Vista 3-4… 

 

 

 

 
 

step 2. Follow the prompt to select a location on your computer to save the export file, give 
your file a name, and save the file.  Note the location of  the saved file on your 
computer.  Do not attempt to open it. 
 

 TIP : Unfortunately, the Macintosh version of  ExamView does not yet offer the 
option to export to WebCT CE 4-6/Vista 3-4 format.  You will need to use the 
PC version of  the software in order to create an export file for SacCT. 

EZTest 
Additional information regarding EZTest, including an overview, FAQs, information about 
acquiring a copy of  the software, and other support pages, can be found on the EZTest Web site 
(www.mhhe.com/eztest).  

1) BUILD YOUR QUIZ 
step 1. Create a new test.   

• If  the test bank that you want to use for your exam is not listed, you will need to 
contact the EZTest publisher (http://mpss.mhhe.com/contact.php). 

• In general, you will select questions from your test bank library to add to your paper 
test.  Once added, questions can be rearranged or removed. 

• For additional instruction on creating an exam using EZTest, see the EZTest support 
pages, or the manual for the application, if  you already have it. 

step 2. Save your completed exam, in the EZTest format (the Save option should save, by 
default, to the EZTest format). 

2) EXPORT TEST 
step 1. Go to the Format/Print screen. 
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|  
  
  

Click WebCT 

 

 

 

 

step 2. From the Publishing Options window, click WebCT at the bottom. 

step 3. Click Generate WebCT® CE6 at the top. 

step 4. Click Save.  Select a location on your computer for the export file, confirm the file 
name, and click Save again. Note the location of  the saved file on your computer.  Do 
not attempt to open it. 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

Callout. Note: add 
ALT text 

 

 

 

1. Click Generate 
WebCT® CE6 

2. Click Save 
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Import into SacCT/WebCT 
Before you begin, make sure that you have enabled the Assessment tool in your course.  To do 
so, go to Manage Course from either the Build or Teach tab.  Select Tools.  Enable the 
Assessment tool from the Tools page. 

To import the exam generated by any of  the three exam applications covered in this handout 
(TestGen, ExamView, EZTest), 

step 1. Log into SacCT and access the course you want to load your quiz questions into. 

step 2. From the Build or Teach tab, click Manage Course on the left (small red toolbox). 

step 3. Select Import from the Manage Course screen. 
  
  
  
  
  
  
  
  
  
  
  
  
  

Select Import 

 

 

 

 

step 4. Click My Computer on the left, from the Content Browser window. 

step 5. Locate and select (or “choose”) the export file on your computer, that you created 
using your exam software (it will be a ZIP file). 

step 6. Click OK.  Your exam will be imported. 

 

 Check the material that was imported.  You should find your imported quiz or exam 
under Assessments.  
 

Finishing Up (BUILD tab): 
 

 Set question points for your exam by clicking into the quiz (from the Build tab).  You 
will be able to change the default points per question from this window. 
 

 To hide/show the quiz, set the duration, access period [dates], quiz results options, and 
other settings for your quiz or exam, edit the exam properties by accessing the Edit 
Properties screen for your imported quiz.  This is done from the ActionLinks menu 
for the quiz, which is located to the right of  the title for your exam (small gray box).  
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1.  Click the ActionLinks 
button 

2.  Select Edit Properties 

 

 

 

 

 

3. Select uppermost 
checkbox 

4. “Uncheck” category 
titles that are selected 

 

 

 

If  you have not implemented assessments before in your SacCT course, it is recommended that 
you go through the SacCT Assessments and Assignments training manual  
(http://www.csus.edu/webct/faculty/docs.stm), or contact an ATCS consultant for additional 
help (http://www.csus.edu/webct/support.stm). 
 
 
 

 USING RESPONDUS 
 
Respondus is a third-party application that can be used to easily create quizzes for SacCT or for 
print.  Questions can be manually input into the program or can be imported from a Word, RTF, 
or text file. To learn more about Respondus, and to request a copy of  the software, visit the Sac 
State Respondus Web site (http://www.csus.edu/atcs/tools/respondus/).  To request the 
software, click the Request Respondus link on the left, under Forms. 

When working with publisher test banks, you might need to use Respondus in the following 
cases: 

 The exam software you have access to does not have the option of  exporting to our 
version of  WebCT. 
 

 You may be running an older version of  one of  the three exam software packages 
covered in this handout.  In this case, it is recommended that you attempt to update 
your software (this will save you time in the long run).  This can usually be done via 
your software’s Help menu. 
 

 Your textbook publisher does not offer exam software, only test bank files (usually in 
Word, RTF, or text format). 

 
 
 

http://www.csus.edu/webct/faculty/docs.stm�
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http://www.csus.edu/atcs/tools/respondus/�


 Academic Technology and Creative Services : CE 8.0 Fall 2009 SacCT : Working with Publisher Test Banks   8 

To use Respondus to create SacCT quizzes or exams from your test bank files, 

step 1. If  you’re not already starting with Word, RTF, or a plain text file, use your exam 
software to generate this type of  file for the quiz or exam that you’ve constructed.  The 
option to create this type of  file is usually located on the Export, or Save As menu of  
your exam software.  

step 2. Modify the test bank file so that it can be imported into Respondus.    

a. Strip out all extraneous text.  This includes headers, footers, and extra text in the 
document.  Questions and answers should be the only items listed in the document.  
For multiple-choice and paragraph/essay questions, follow this format: 
  
  
  
  
  
  
  
  
  

  
  
  
  
 

 

Multiple-choice questions 

Title: Speed of  Light 
1. Who determined the exact speed of  light? 
a. Albert Einstein 
*b. Albert Michelson 
c. Thomas Edison 

  d. Guglielmo Marconi 

Paragraph/Essay questions 

Type: P 
Title: Michelson-Morely experiment 
4. How is the Michelson-Morley experiment related 
to Albert Einstein's theory of  relativity? 

▪ The Title line is optional.  If  you don’t specify titles, the first 10 characters of  the 
question wording will be used as the title. 

▪ Paragraph/essay questions must include the Type indicator line as shown above. 

▪ A space MUST be included after the period that follows a question number or 
answer letter. 

▪ For multiple-choice questions, the correct answer must be indicated with an asterisk 
placed directly before the letter or the correct answer. 

▪ Questions and answers must be listed/numbered in the correct order. 

b. Other questions types that can be imported include true-false, short answer, matching 
and multiple response questions.   

▪ Formatting requirements for these additional question types is listed in the 
ATCS handout Respondus: Creating Quizzes for SacCT 
(http://www.csus.edu/training/handouts/workshops/creating_quizzes_with_re
spondus.pdf) (PDF file). 

http://www.csus.edu/training/handouts/workshops/creating_quizzes_with_respondus.pdf�
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step 3. Import the test bank file into Respondus.   

a. For instructions on doing this, refer to the ATCS handout Respondus: Creating 
Quizzes for SacCT 
(http://www.csus.edu/training/handouts/workshops/creating_quizzes_with_respo
ndus.pdf) (PDF file).  Instructions on importing can be found in the Importing 
Questions from Text Files section. 

step 4. Publish your completed Respondus quiz file to your SacCT course.   

a. For instructions, refer to the Respondus handout mentioned in Step 3 above.  
Instructions on publishing a quiz can be found in the Publishing a Quiz to SacCT or 
For Print section in the document. 

Respondus can also be used to apply settings for a quiz (such as duration, dates available, etc).  Or 
you can set up these options from within your SacCT course.  Refer to the Finishing Up 
section of  this document (on page 6), to make certain that your quiz or exam is ready to go! 

 

 TIP : Some publishers offer Respondus-formatting test banks, which can be 
opened directly in Respondus without additional formatting.  To see if  one is 
available from your publisher, see the Respondus Test Bank Network site 
(http://www.respondus.com/test bank/index.shtml).  Instructions on using 
Respondus-formatted test banks in Respondus are also available on this site. 
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